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1. Dulezité

Tato elektronickd uzivatelskd prirucka je urcena
pro kazdého uZivatele tohoto monitoru Philips.
Pred pouzivdnim monitoru si prectéte tuto
uzivatelskou prirucku. Obsahuje dilezité informace
a pozndmky k pouzivani vaseho monitoru.

Z3aruka Philips je platnd, pokud je vyrobek pouZzivdn
pro navrzenou potrebu v souladu s ndvodem a

po prilozen( origindlu faktury nebo pokladnim
dokladem, oznacujicim datum ndkupu, jméno
prodejce a modelové a vyrobnf &islo vyrobku.

1.1 Bezpecnostni opatreni a udrzba

@ Varovani

Pouziti kontrol, Uprav nebo postupl jinym
zpUsobem nez je stanoveno v této dokumentaci
muze vést k ohroZen( Sokem, elektrickym a/nebo
mechanickym riziklm.

Prectéte si a dodrzujte tyto instrukce pri
zapojovéni a pouzivani vaseho PC monitoru.

Pouzivani

*  Udrzujte monitor mimo primé slunecni zarenf
a v bezpecné vzddlenosti od veskerych zdrojd
tepla.

»  Odstrarite veskeré predméty, které by mohly
spadnout do vétracich otvord nebo zabranit
dostate¢nému chlazeni elektroniky monitoru.

*  Nezakryvejte vétracl otvory ve skiffice.

*  Umistéte monitor na takové misto, ze kterého
bude elektrickd zdstr¢ka a zdsuvka snadno
pristupnd.

* Jestlize jste vypnuli monitor odpojenim
napdjectho kabelu nebo kabelu napdjeciho
adaptéru, pred pripojenim kabelu pockejte 6
sekund, aby monitor fungoval normdiné.

* Vidy pouzivejte napdjeci kabel schvdleny
spolecnosti Philips. Pokud napd jeci kabel
chybi, obratte se na nejblizsi servisnf stredisko.
(Viz informace o strediscich zdkaznické péce)

*  Béhem pouzivdni nevystavujte monitor
nadmémym otresim nebo ndrazim.

*  Pri pouzivani nebo premistovani do monitoru
nekopejte a zabrarite pripadnému padu.

Udrzba

*  Aby byl monitor chrdnén pred moznym
poskozenim, nevyvijejte na panel LCD
nadmeémy tlak. Pri premistovani zvedejte
monitor za rdm; pfi zvedani monitoru
nesahejte rukou nebo prsty na panel LCD.

* Nebudete-li monitor delsf dobu pouzivat,
odpojte jej ze zdsuvky.

*  Pred ocisténim mimé navihéenym hadrikem
monitor odpojte ze zdsuvky. Je-li vypnuté
napdjeni, Ize obrazovku otfit suchym hadrikem.
K &igténi monitoru nikdy nepouZzivejte
organicka rozpoustédla, jako napriklad alkohol
nebo Cistice s obsahem Epavku.

» Zabrafite nebezped( Urazu elektrickym
proudem nebo trvalého poskozeni monitoru
a chrarite monitor pred prachem, destém,
vodou nebo nadméme vihkym prostredim.

* Pokud dojde k namoceni monitoru, co
nejdiive jej osuste suchym hadrikem.

*  Vnikne-li do monitoru cizf ldtka nebo voda,
ihned vypnéte napdjeni a odpojte napdjecl
kabel. Odstrarite cizf ldtku nebo vodu z
monitoru a odeslete jej do servisniho strediska.

*  Monitor neskladujte ani nepouZzivejte
na mistech vystavenych teplu, prfimému
slune¢nimu zdr'eni nebo extrémnim teplotam.

*  Chcete-li zachovat optimdini vykonnost
monitoru a prodlouZit jeho Zivotnost,
pouZivejte jej na misté, které splfiuje ndsledujici
rozsahy teplot a vihkosti.

o Teplota: 0-40°C 32-95°F
o Vlhkost: 20-80% relativni vihkosti



+  DULEZITE: Pfed ponechdnim monitoru bez
dozoru vzdy aktivujte spofi¢ obrazovky. Bude-
li na vasem monitoru zobrazen neménicf
se staticky obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky. Dlouhodobé
neprerusované zobrazeni nehybného nebo
statického obrazu mize zpUsobit ,,vypdleni*
obrazovky, rovnéz zndmé jako ,,dosvit" nebo
,,zobrazen( duchd".

., Vypélen*, ,dosvit" nebo , zobrazeni duchd*
je dobr'e zndmy jev u technologie paneld LCD.
V mnoha pripadech , vypdleni,, dosvit" nebo
,,zobrazenf duchd' postupné zmizf po urcité
dobé mimo provoz.

D Vystraha

Vdzné priznaky ,vypdleni, , dosvitu" nebo
,,zobrazenf duch("* nezmizf a nelze je opravit. Na
vyse uvedené poskozen se nevztahuje zdruka.

Servis

*  Kryt pldsté mdze oteviit pouze kvalifikovany
servisni pracovnik.

* Pokud je pro opravu vyZzadovdna dokumenta-
ce nebo integrace, obratte se na nejblizsi ser-
visn( stredisko. (Viz kapitola , Stredisko zdkaz-
nické péce")

* Informace o prevdzeni najdete v ¢ésti ,, Tech-
nické Udaje".

* Neponechdvejte monitor v auté nebo v zava-
zadlovém prostoru auta na primém slunci.

€& Pozniamka

Pokud monitor nefunguje spravné nebo pokud
si nejste jisti, jaké kroky je treba provést po
provedeni pokynU v této prirucce, obratte se na
servisniho pracovnika.

1.2 Vysvétleni zapisu

Ndsledujici pododdily popisuji zptsob zdpisu, ktery
se pouzivd v této prirucce.

Pozndmky, upozornéni a vystrahy

Na strdnkdch této prirucky mizete narazit na text,
ktery je opatreny symbolem a je vytistén tucné
nebo kurzivou. Takové Useky obsahuji pozndamky,
upozornéni a vystrahy. Jejich pouzitf je ndsledujicf:

© Poznamka

Tento symbol oznacuje dllezité informace a
ndvrhy, které pomédhajf Iépe vyuzit pocitacovy
systém.

© Upozornéni

Tento symbol oznacuje informace, které objasriuj,
jak se vyhnout moznému poskozenf zafizeni nebo
ztrdté dat.

) Vystraha

Tento symbol oznacuje nebezpedi télesného
ublizenf a vysvétluje, jak se danému problému
vyhnout.

Nekteré vystrahy se mohou objevit v rlizné
podobé a nemusf byt uvozeny symbolem. V
takovém pripade je konkrétnf vyznacenf vystrahy
nafizeno Uradem pro regulaci.



1.3 Likvidace produktu a obalového materidlu

Likvidace elektrickych a elektronickych zafizeni -
WEEE

This marking on the product or on its packaging
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic
appliances, this product may not be disposed

of with normal household waste.You are
responsible for disposal of this equipment through
a designated waste electrical and electronic
equipment collection. To determine the locations
for dropping off such waste electrical and
electronic, contact your local government office,
the waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that can be
recycled and reused. Specialized companies can
recycle your product to increase the amount of
reusable materials and to minimize the amount to
be disposed of.

All redundant packing material has been omitted.
We have done our utmost to make the packaging
easily separable into mono materials.

Please find out about the local regulations on how
to dispose of your old monitor and packing from
your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be recycled
and reused.

To learn more about our recycling program please
visit www.philips.com/about/sustainability/recycling,




2. Sestaveni monitoru

2.1 Instalace

273E3L/273E31LH
El Obsah krabice

%%art

Ps PHILIPS

DVI (nepovinny) VGA (nepovinny) Kabel zvuku (nepovinny)

E1 Namontuijte stojanek podstavce
273E3L/273E3LH

1. Umistéte monitor obrazovkou dold na mékky
a hladky podklad, aby nedoslo k poskrdbani
obrazovky.

2. Uchopte monitor obéma rukama a pfipevnéte
stojdnek podstavce do sloupku podstavce.

IS



El Pripojeni k poéitaci
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Vstup napdjen(

Vstup VGA

Vstup DVI-D (k dispozici pro vybrané
modely)

Zamek proti krddeZi Kensington
Vstup HDMI (k dispozici pro vybrané
modely)

Vstup zvuku (k dispozici pro vybrané
modely)

Pripojen( k pocitaci

1.

Pevné pripojte napdjeci kabel k zadnf
strané monitoru.

Vypnéte pocitac a odpojte jeho napdjecl
kabel.

Pripojte signdlovy kabel monitoru do
video konektoru na zadnf stran¢ pocitace.
Zapojte napdjeci kabel pocitace a
monitoru do nejblizsi zdsuvky.

Zapnéte pocita¢ a monitor. Jestlize se

na monitoru objevi obraz, instalace je
dokoncena.

2.2 Ovladani monitoru

273E3L
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El Popis vyrobku z éelniho pohledu
@ =/0K :Slousf ke vstupu do nabidky OSD.

o < : Slouzi k ndvratu na priedchozi Uroven
OSsD.

: Slouzi ke zméné na zobrazeni 4:3.

(C

: Slouzi k zapnuti a vypnuti napdjenf
monitoru.

: Slouzi k nastaveni OSD.

: Slouzi ke zméné zdroje vstupniho
signdlu.

:Smartlmage Lite. Lze vybrat
néktery ze Sesti rezimu: Standard
(Standardn), Internet a Game (Hra).

: Slouzi k nastaveni hlasitosti displeje.

® 00 00
5 &%

o)



E1 Popis zobrazeni funkci na obrazovce
Co je nabidka na obrazovce (OSD)?

Funkcf nabidky obrazovky (On-Screen Display,
OSD) jsou vybaveny vsechny monitory LCD
Philips. UmoZzniuje koncovému uZivateli upravovat
vlastnosti obrazovky nebo vybirat funkce
monitoru primo prostrednictvim zobrazeného
okna s pokyny. Nize je uveden priklad prijemného
rozhrani obrazovky:

Zakladni a jednoduché pokyny k ovladacim
tlacitkdm

Ve vySe uvedené nabidce obrazovky OSD mohou
uZivatelé pomocf tlacitek w A na prrednim rdmu
monitoru pohybovat kurzorem, OK potvrzovat
vybér nebo zménu.

Nabidka OSD
NiZe je uveden celkovy pohled na strukturu OSD.

Tento prehled mlzete vyuzit, budete-li chtit
pozdéji prozkoumat rliznd nastavent.

Main menu Submenu
VGA
— Input E
DVI (available for selective models)
Picture Format —  Wide screen 43
[— Picture
Brightness ~ — 0~100
Contrast ~ — 0~100
SmartContrast — On, Off
ColorTemp, — 6500K, 9300K
(— Color
SRGB
User Define Red:0~100
E Green: 0~100
Blue:0~100
— language  — English Espaiol, Francais, Deutsch, ltaliano,
Portugués,Pycckuit, ][I, Tiirkge
[ Horizontal ~ — 0~100
(— Vertical — 0~100
[— 0D Settings
[— Transparency — Off,1,2,3,4
— 0SDTimeout — 5,10,20,30,60
— Auto
[— H.Position — 0~100
|— V.Position — 0~100
— Setup [ Phase — 0100
{— Clock — 0100
|— Resolution Notification — On, Off
— Reset — Yes,No
L— Information
Mainmenu  Submenu
VGA
— Input
v
HOMI
Picture Format — Wide Screen3
{— Picure
Brightness  — 0~100
Contrast ~ — 0~100

SmartResponse— On, Off

SmartContrast — On, Off

Stand-Alone  — On, OFf
b audo ]:

Mute — onoff
ColorTemp.  — 650K, 9300K
{— Color
sRGB Red: 0~100
User Define E Green: 0~100
Blue:0~100
{— Language  — English Espariol, Frangais, Deutsch, Italiano,
Portugués,Pycekuit, Tl Tirke
— Horizontal  — 0100
{— Vertical — 0~100
{— 05D Settings

[ Transparency — Off,1,2,3,4

— 0SDTimeout — 5/10,20,30,60

— Auto

{— OverScan — on0ff

{— H.Positon — 0-100

{— V.position — 0-100
L sewp

[ Phase — 0~100

{— Clock — 0~100

{— Resolution Notification — On, Off

[ Reset — Yes,No

L Information



El Poznamka k rozliseni

Tento monitor je uréen pro optimdini vykon pri
nativnim rozliseni 1920x1080 pii 60 Hz. Kdyz je
monitor zapnut pri jiném rozlisenf, na obrazovce
se zobrazf vystraha: Pro dosazeni nejlepsich
vysledkd pouzijte rozliseni 1920x1080 pri 60 Hz.
Zobrazovani vystrahy na nativnf rozlisenf Ize

vypnout v ¢asti Setup (Nastaveni) v nabidce OSD.

B Fyzické funkce

Ndéklon

pHILIPS

2.3 Odpojte stojanek podstavce a podstavec

El Demonté? stojanku podstavce

Nez zacnete demontovat podstavec monitoru,
postupuijte podle pokynl nize, aby se zabranilo
poskozeni nebo zranént.

1. Umistéte monitor obrazovkou doll na mekky
podklad, aby nedoslo k poskrabani obrazovky.

2. Stisknéte zajistovaci svorky a oddélte stojanek
podstavce od sloupku podstavce.




E1 Demontdz podstavce © Poznamka
Tento monitor je kompatibilni's 1700 mm x 100
Podminka: mm montdznim rozhranim kompatibilnim se stan-
dardem VESA.
» Montdz drzéku standardu VESA

. PHILIPS
1. Odmontujte 3 kryty Sroubd. v

> 100mm G

t
|

[ O S—C

(K
I

2. Odmontujte 3 Srouby a potom sejméte podsta-
vec z monitoru.




3. Optimalizace Obrazu

3.1 Smartimage Lite
E Cojeto?

Funkce Smartlmage Lite nabizi scéndre, které
optimalizujf zobrazenf( rdznych typd obsahu a
dynamicky zlep3uje jas, kontrast, barvy a ostrost

v redlném case. Funkce Philips Smartimage Lite
prinasi optimalizované zobrazeni monitoru bez
ohledu na to, zda pracujete s aplikacemi, prohlizite
obrdzky nebo sledujete video.

E1 Prog to potiebuiji?

Protoze chcete sledovat monitor; ktery prinasi
optimalizované zobrazen{ viech vasich oblibenych
typl obsahu. Software Smartlmage Lite dynamicky
upravuje jas, kontrast, barvy a ostrost v redlném
Case pro dosazeni nejlepsiho zdZitku ze sledovdn(
monitoru.

E Jak to funguje?

Smartimage Lite exkluzivni $pickova technologie
spole¢nosti Philips, kterd analyzuje obsah zobrazeny
na obrazovce. Na zékladé vdmi zvoleného scéndre
technologie Smartlmage Lite dynamicky zlepsuje
kontrast, sytost barev a ostrost obrazu pro
vylepseni zobrazovaného obsahu — vie v redlném
Case stisknutim jediného tlacitka.

B Jak aktivovat Smartlmage Lite?

PRILIPS,

1. Stisknutim B se Smartlmage Lite zobraz na
obrazovce;

2. Opakovanym stisknutim [BJ) mdzete prepinat
mezi rezimy Standard (Standardni), Internet,
Game (Hra).

3. Zobrazeni Smartlmage Lite zUstane na
obrazovce po dobu 5 sekund nebo mUzete
rovnéz potvrdit stisknutim tlacitka ,, OK".

4. Po aktivaci technologie Smartimage Lite je
automaticky deaktivovano schéma sRGB. Aby
bylo mozné pouzit schéma sRGB, je treba
deaktivovat funkci Smartimage Lite stisknutim
tla¢ftka B na prednim panelu monitoru.

Kromé tlacitka Bf) pro posun dolti mizete rovné?
provést vybér stisknutim tlacitek w A, potvrdit
vybér stisknutim tlacitka ,, OK" a ukondit nabidku
Smartlmage Lite OSD.

Lze vybrat néktery ze Sesti rezimd: Standard
(Standardni), Internet, Game (Hra).



@ SmartImage U™

Standard

Internet

Game

Standard (Standardni): Vylepsuje text a
snizuje jas pro zvysenf Citelnosti a omezen(
naméhan( zraku. Tento rezim podstatné
zvysuje Citelnost a produktivitu pri praci

s tabulkami, soubory PDF, skenovanymi
¢lanky nebo jinymi obecnymi kanceldrskymi
aplikacemi.

Internet: Tento profil kombinuje vylepsen(
sytosti barev, dynamického kontrastu a
ostrosti pro zobrazenf fotografif a dalSich
obrdzkd s vynikajici Cistotou v Zivych barvéch
—to ve bez artefaktl a vybledlych barev.
Game (Hra): Tento profil prindsi nejlepsf
herni zazitek pro hrace, protoze aktivuje
prebuzeny okruh pro optimdlni dobu
odezvy, omezeni zubatych okrajd rychle

se pohybujicich objektd na obrazovce a
vylepsen( kontrastniho poméru pro jasné a
tmave scény.

10

3.2 SmartContrast
E Cojeto?

Jedine¢nd technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastni pomér monitoru LCD pro maximdlni
vizudlni Cistotu a poZitek ze sledovani. Zvysuje
podsvicen( pro jasn&jsi, ostr'ejsi a jasn&jsi obraz
nebo snizuje podsvicen( pro jasné zobrazenf

obrazu s tmavym pozadim.
Bl Prog to potiebuii?

Z4date nejvysi vizudlni Eistotu a pohodlf sledovani
jakéhokoli typu obsahu. SmartContrast dynamicky
rfdi kontrast a upravuje podsviceni pro jasné, ostré
a jasné zobrazenf her a videa nebo pro zobrazenf
jasného, citelného textu pro kanceldrskou praci.
Omezenim spotreby monitoru Setfite néklady a
prodluzujete Zivot vaSeho monitoru.

E Jak to funguje?

Po aktivaci bude funkce SmartContrast v redném
Case analyzovat zobrazeny obsah a upravovat
barvy a fidit intenzitu podsvicenf. Tato funkce
bude dynamicky vylepSovat kontrast pro skvély
zdzitek pii prohlizenf fotografif nebo hrani her.



3.3 Philips SmartControl Lite

Novy software SmartControl Lite od spolec¢nosti
Phillips umozriuje ovlddat monitor prostrednictvim
snadno pouzitelného grafického rozhrani na
obrazovce. SloZitd nastaveni jsou minulosti, protoze
tento uZivatelsky prijemny software vds provede
jemnym vyladénim rozlidenf, kalibraci barev,
nastavenim frekvence/faze, nastavenim bilého bodu
RGB atd.

Tento software zalozeny na pritazlivych
animovanych ikondch kompatibiln{ se systémem
Windows 7, ktery je vybaven nejnovejsi technologif
v jadrovém algoritmu pro rychlé zpracovani a
odezvu, je pripraven rozsifit vasi zkuSenost s
monitory Philips!

El Instalace

* Postupujte podle pokynt a dokoncete instalaci.

*  Mdzete spustit po dokoncenf instalace.

*  Chcete-li spustit pozdéji, mizete klepnout na
zéstupce na pracovni plose nebo na panel
nastroju.

PHILIPS www philips.com/welcome

Recuired seps Monitor driver and software installation

Sysen requremens:

+ PC running Windows 7, Viss, XP 200098

Philps SmarcControl

Por hed Chnese

I

Prvni spusténi —Wizard (Pruvodce)

*  Pri prvnim spusténi po instalaci prejde
SmartControl Lite automaticky na Wizard
(Pravodce).

» Tento privodce vds provede podrobnym
nastavenim vykonu monitoru.

*  Prlvodce muzete rovnéz spustit pozdéji z
nabidky Plug-in (Zasuvny modul).

*  Dal¥f moZnosti mlZzete nastavit bez
privodce prostrednictvim podokna Standard
(Standardni).

W SmartControl 2 phips 22581 (CS30715000001) ()X

SmartControl Lite PHILIPS

Wizard

Adjust




B3 Spusténi s podoknem Standard (Standardni):

Nabidka Adjust (Nastaveni):

Nabidka Adjust (Nastaveni) umozriuje upravit
Brightness (Jas), kontrast (Kontrast), Focus
(Ohnisko), Position (Poloha) a Resolution

(Rozligen).

Md0Zete postupovat podle pokyni a provést

nastavenf.

Cancel (Storno) vyzivéd uzivatele, chcete-li

ukoncit instalaci.

8 smartcontol

SmartControl Lite

]

Adiust Load

()
Brightness
Color .
=5
. o
—
LE['? poseen
Options
“
ii et
Help
' smartControl
SmartControl Lite
Adjust
Brightness
Color e
A
_ Yo
g
\g poseon
Options.
“
Resotion

&

2-Phips 22581 (CS30715000001) () (X
PHILIPS

Brightness

Improperly adjusted Brightness wil result 3 loss of
detai n darker image areas. Adjust the Brightness for
the best possble picture quaity.
1. Lower the Brightness to the minimum k
2. Raise the Brightness to the desred level
3. Adjust the Brightness as needed to achieve
an equal separation of the stripes.

Brightness 100
- +

Undo Reset

2 - Phips 225B1 (CS30715000001)

PHILIPS

x

Contrast

Adjust the Contrast (use the sider) to keep detais in
lghter image areas.
1. Rase the Contrast unti the numbers 1and 2
longer vsibl.
er the Contrast to make the
and 3 reappear. The number 1
should remain barely visble

Contrast. 50

(3

g A

Undo Reset

8 smartcontol

SmartControl Lite

a R

Color

€

Options

&

Help

8 smartcontrol

Brghtness
Contrast
Focus

Postion

Resolution

SmartControl Lite

Adiust

8 smartcontrol

Brightness

Contrast
A
ocu

Poskion

w

Resolution

SmartControl Lite

Adiust

Optons

Brightness
Contrast
24

Focus

Postion

%
8
£
g

2 - Philps 22581 (C530715000001) ()%

PHILIPS

vertical bands dissppear.
ightest stting to mnimze

pitch 50

= =

Phase It

= +
Undo Auto setup

2 - Phips 22581 (CS30715000001)

PHILIPS

Position

Use the Position buttons to center the image on
your display. Using this tool, you can posttion the image

2 or right.
1. Use the Up/Down buttons to center the image

2. Use the Left/Right buttons to center the image
horzontaly.

Undo Reset

2-phips 2591 (csa0715000001) (X
PHILIPS

Resolution

You are currently 3t 3 Preferred resolution. For your
dsply to show crisp, dlear text, colors, and images,
your display should be set to fs Preferred resolution.

T your display s at a Non-Preferred res:
on the Preferred button to change your
Preferred,

I Enable Resolution Notier

Picture Format
I~ 43 aspect ratio



Nabidka Color (Barva):

Nabidka Color (Barva) umoZzriuje upravit RGB,
Black Level (Uroveri &erné), White Point (Bily
bod), Color Calibration (Kalibrace barev) a
Smartimage Lite (viz ¢ast Smartlmage Lite).
Mdzete postupovat podle pokyn( a provést
nastavent.

V ndsledujici tabulce vyhledejte polozku
podnabidky na zakladé vaseho vstupu.

Priklad pro Color Calibration (Kalibrace barev)

8 smartControl 2- Philps 22581 (€530715000001) ()X

SmartControl Lite PHILIPS

Black Level

Improperly adjusted Black Level wil resul i a loss of

detai n darker mage aress. Adjust the Black Level for

the best possble picture qu

1. Adjust the black level of the Red, Green, and
Blue using the sider bars.

i

n

Adiust Re8
| .

Biack Level = +

White Pont -

Display Gamma =

J
hoes unco

g gﬁ

Reset
optons cabraton
g ap
srartimage

—

W smartControl 2.- Phiips 22581 (CS30715000001) ()X

SmartControl Lite PHILIPS

White Point

‘White Point s the pont at which equal combmations
of red, green, and ntensity crea

| 1. Please select the White Pont value for the best
] possbl cobr qualty.
Adjust Rea
Color White Pont:
— White Pont 6500K
\E Disply Gamma = ( &
: -
Undo Reset
Optons Caibration
A ap
Smartimage
Hep
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8 smartControl 2-Phips 22581 (CS30715000001) ()X

SmartControl Lite PHILIPS

Display Gamma

Gamma is 2 component of the pixel brightness n 2
disply. A lower Gamma vakue produces brighter pixels
and a higher Gamima vakue produces darker paxes. The
defauk value for Gamm s 2.2

Off.

To adjust Gamma, Smartin t
e adjusting

e mu
Cick the Smartlmage Off button b
ma.

\Q m

Adiust
d s 1. Use the sider to select the desred Gamma
o - .
= -/
\Q Dipby Gamma
-y
g undo Reset
Options Calbration
ap
Smartimage
Help
8 smartControl 2 - Philps 22581 (C530715000001) [F] %)

SmartControl Lite PHILIPS

Calibration

Adiust RG8
calibration tooks.
3. Fnaly, press Start to begn the calibration
process.
Black Level
' Enable cobor cabration
Colorsoftware desgned n coleboration wth Joseph
’ Holmes,
Color White Pont Protected by U.S. Patent No. 6,686,953
220 #
\Q Disply Gamma
Optons Galbration
ap
Smartlmage
Hep

Show Me start

Quick View

Tlacitko ,,Show Me* (Predvést) spusti vyukovy
program pro kalibraci barev.

Start (Spustit) — zahdji sekvenci kalibrace barev
o 6. krocich.

Quick View (Rychlé zobrazenf) nacte zobrazenf
pred/po.

Chcete-li se vratit na hlavni stranku Color
(Barva), klepnéte na tlacitko Cancel (Storno).
Enable color calibration (Povolit kalibraci
barev) — ve vychozi konfiguraci je zapnuto.
Pokud tato polozka nenf zaskrtnuta, kalibraci
barev nelze provést a tlacitka rychlé zobrazenf
nejsou k dispozici.

Na kalibracni obrazovce musf byt zobrazeny
informace o patentech.



Calibration Screen (Obrazovka kalibrace) prvni
barvy:

* Tlacftko Previous (Predchozi) je deaktivovano
az na obrazovku druhé barvy.

*  Tlacftko Next (Dalsi) slouzi k prechodu na
nasledujici cil (6 cild).

* Tlacftko Konecny slouzi k prechodu na File >
Presets (Soubor > podokno Predvolby).

* Tlacitko Cancel (Storno) slouzi k ukoncenf
uzivatelského rozhranf a k ndvratu na stranku
zdsuvnych moduld plug-in.

Smartlmage Lite
Smartimage — umozriuje uZivateli zménit nastaven(
pro vylepseni zobrazeni na zakladé obsahu.

Kdyz je nastavena moznost Entertainment
(Zabava), jsou polozky SmartContrast a
SmartResponse k dispozici.

8 smartControl X
SmartControl Lite PHILIPS

Smartimage

SmartImage provides diferent brightness and
contrast levels to accomodate today's wide range of
ications.

q that is most comfortable or
iewing your application. Akernativel,
! the one that best descrbes fs type.

Adjust. RGB

@ M
(5]

Cobor White Pont
N -
Display Gamma
L
Options Glbration
=
ap
srairage ~
Game

o B

Internet Standard
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Options>Preferences (Moznosti>Predvolby)
—Tato moznost bude aktivni pouze po vybéru
polozky Preferences (Predvolby) v rozeviracf
nabidce Options (MozZnosti). Na nepodporovaném
zobrazovacim zarizeni s podporou DDC/CI jsou k
dispozici pouze karty Help (Ndpovéda) a Options

(Moznosti).
B smartControl 2 - Phips 22581 (CS30715000001) (2)(X)
SmartControl Lite PHILIPS

Preferences

You can use the folowing options to configure
I

t-cicking on desktop

ngmn:as

i

Adjust Audio Select Bnguage:

Presets

Muli Monitors

Englsh E
\g Auto Prot

~-

Color Tnput

ey

\g P

2
Options.

Help

Zobrazi nastaven( aktudlnich predvoleb.
Zaskrtnuté tlacitko aktivuje funkci. Zaskrtdvact
policko je prepinac.

PoloZka Enable Context Menu (Povolit mistni
nabidku) na pracovni plose je ve vychozf
konfiguraci zaskrtnutd (Zapnuto). Po aktivaci
polozky Enable Context Menu (Povolit mistni
nabidku) se zobrazi vybéry SmartControl
Premium pro funkce Select Preset (Vybrat
predvolbu) a Tune Display (Ladéni zobrazeni)
na pracovni plose klepnutim pravym tlacitkem
mysi na mistni nabidku. Volbou moznosti
Deaktivovano bude polozka SmartControl
Premium odstranéna z mistni nabidky pravym
tlacitkem mysi.

PoloZka Enable Task Tray (Povolit ikonu na
hlavnim panelu) je ve vychoz( konfiguraci
zaskrtnutd (Zapnuto). Po aktivaci polozky
Povolit mistnf nabidku se zobrazi nabidka
SmartControl Lite na hlavnim panelu.
Klepnutim pravym tlacitkem mysi na ikonu

na hlavnim panelu se zobrazi moznosti
nabidky Help (Ndpovéda), Technical Support
(Odbornd pomoc), Check for Update
(Vyhledat aktualizace), About (O aplikaci) a
Exit (Konec). Kdyz je deaktivovdna polozka
Enable task tray menu (Povolit nabidku na
hlavnim panelu), ikona na hlavnim panelu
zobrazuje pouze moznost EXIT (KONEC).



* Polozka Run at Startup (Spustit pri startu) je Options>Audio (Moznosti>Zvuk) —Tato moZnost

ve VthOZ" konﬂgtjraci zaéklrtnu,té (Zapnuto). bude aktivni pouze po vybéru polozky
KdyzZ je tato poloZka deaktivovdna, funkce Audio (Hlasitost) v rozeviraci nabidce Options
SmartControl Lite se nespusti pri startu (Moznosti).

nebo nebude na hlavnim panelu. Funkci
SmartControl Lite Ize spustit pouze
prostrednictvim zdstupce na pracovni plose
nebo prostrednictvim souboru programu. Kdyz
toto poli¢ko nenf zaskrtnuté (Deaktivovano),

Na nepodporovaném zobrazovacim zarizeni s
podporou DDC/CI jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

vz Y e viv s 1 smartcontrol 2 -Phiips 22581 (CS30715000001) (2 (X

Zadnd predvolba nastavend pro spusténi pri

startu nebude nactena. SmartControl Lite PHILIPS
* Enable transparency mode (Aktivovat rezim Audio

he integrated loudspeakers by

prihlednosti) (Windows 7,Vista, XP).Vychoz{
nastaveni je 0 % neprihlednost.

Options>Input (Moznosti>Vstup) —Tato moznost

bude aktivni pouze po vybéru polozky Input \
(Vstup) v rozeviracf nabidce Options (Moznosti). Goor
Na nepodporovaném zobrazovacim zar{zen( s
podporou DDC/CI jsou k dispozici pouze karty

. . N b Options
Help? (Népovéda) a Options (Mo;nostl). Zadné -~
dal3i karty funkce SmartControl Lite nejsou k \ 4
dispozidi. = o &
B smartControl 2 - Philps 22581 (C530715000001) (2]
SmartControl Lite PHILIPS

Input

Dlay has two i

Adjust Audo

Color

. ]

\ﬂ "
=i

Analog In Digial In

* Zobrazi podokno s pokyny Source (Zdroj) a
nastaven( aktudintho zdroje vstupu.

* U zobrazovacich zafizenf s jednim vstupem
nenf toto podokno zobrazeno.
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Help>User Manual (Napovéda>Uzivatelska
prirucka) —Tato moznost bude aktivni pouze
po vybéru polozky User Manual (Uzivatelska
prirucka) v rozeviraci nabidce Help (Ndpovéda).
Na nepodporovaném zobrazovacim zarizen( s
podporou DDC/CI jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

8 smartcontrol 2-Phiips 22581 (CS30715000001)

PHILIPS

2%

SmartControl Lite

User Manual

Adjust

Options

4

User Manual Tech. Support

Help>Version (Napovéda>Verze) —Tato moznost
bude aktivni pouze po vybéru polozky Version
(Verze) v rozeviraci nabidce Help (Ndpovéda).
Na nepodporovaném zobrazovacim zafizen( s
podporou DDC/CI jsou k dispozici pouze karty
Help (Ndpovéda) a Options (MozZnosti).

W smartcontol 2. Phips 22581 (Cs30715000001) (T

SmartControl Lite PHILIPS

Version

LUATION dtune-plp-R2009-12-17-

ATE2 AP1

at Displays, Inc.

Adiust

o
{ ®
8
Color n
o
\ a
. et
Options s
i
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Context Sensitive menu (Mistni nabidka)
Context Sensitive Menu (Mistni nabidka) je ve
vychoz( konfiguraci Aktivovdna. Nabidka bude
zobrazena po zaskrtnutf polozky Enable Context
Menu (Povolit mistni nabidku) v ¢asti Options

> podokno Preferences (Moznosti > podokno
Predvolby).

@ SmartControl
Select Preset
Tune Display

»

Context Menu (Mistni nabidka) obsahuje ctyri
polozky:

*  SmartControl Lite - po vybéru se zobrazf
obrazovka O aplikaci.

Select Preset (Vybrat predvolbu) — nabizi
hierarchickou nabidku ulozenych preedvoleb
pro okamzité pouziti. Aktudlné vybrand
predvolba je oznacena zaskrtnutim. V
rozeviraci nabidce Ize rovnéz vybrat polozku
Predvolby vyrobce.

Tune Display (Ladéni zobrazeni) — otevre
ovladaci panel SmartControl Lite.
Smartlmage Lite — zkontrolujte aktudlnf
nastaveni Standard (Standardni), Internet,
Game (Hra).



Aktivovana nabidka hlavniho panelu

Nabidku hlavniho panelu lze zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl Lite
na hlavnim panelu. Klepnutim levym tlacitkem Ize
spustit aplikaci.

Help

Technical Support
Check for Update
About

Exk

Hlavnf panel obsahuje pét polozek:

Help (Napovéda) — pristup k souboru s User
Manual (uzivatelskou priruckou): Otevie
soubor s User Manual (uZivatelskou priruckou)
v okné vychoziho prohlizece.

Technical Support (Odbornd pomoc) —
zobrazf strdnku odborné pomoci.

Check for Update (Vyhledat aktualizace) —
zobrazi tvodni strdnku PDI a porovna verzi
uZivatele s nejaktudlnéjsi dostupnou verzi.
About (O aplikaci) — zobrazi podrobné
referencni informace: verze produktu,
informace o vyddni a ndzev produktu.

Exit (Konec) - ukonci SmartControl Lite

Chcete-li znovu spustit funkci SmartControl Lite,
vyberte polozku SmartControl Lite z nabidky
Program, poklepejte na ikonu na pracovni plose
pocitace nebo restartujte pocital.

PHILIPS

SmartControl

SmartControl
“ersion 3.20
dhane-standard-R2007-D1-04-1151-23
Copyright 1983-2007 Pertrak Displays, Inc.
Patents Pending
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Deaktivovana nabidka hlavniho panelu

Kdyz je hlavni panel deaktivovan ve slozce
Preference (Predvolby), je k dispozici pouze ¢dst
EXIT (KONEQ). Chcete-li funkci SmartControl
Lite zcela odstranit z hlavniho panelu, deaktivujte
polozku Run at Startup (Spustit pri startu) v ¢asti
Options>Preferences (Moznosti>Predvolby).



4. Technické udaje

273E3L/273E3LH
Typ panelu LCD TFT-LCD
Podsvicen( WLED 273E3L/273E3LH
Velikost panelu 27" (68,6 cm)
Pomér stran 16:9
Rozte¢ obrazovych bodl 0,31 x 0,31 mm
Jas 300 cd/m?
SmartContrast 20,000,000:1
Kontrastni pomér (typ.) 1200:1
Doba odezvy (typickd) 5 ms (273E3L), 1 ms (273E3LH)
Optimaln{ rozlisenf 1920 x 1080 pri 60 Hz
Zorny Uhel 170° (H) / 160° (V) pri C/R>10
VylepSeni obrazu Smartlmage Lite
Barevnost displeje 16,7 M
Vertikdni obnovovacf 56 Hz - 76 Hz
frekvence
HorizontdIni frekvence 30 kHz — 83 kHz
sRGB ANO
| Momnostipfipojeni ]
Vstup signalu DVI-D (digitélni), VGA (analogovy)
Vstupnf signdl Oddélend synchronizace, synchronizace podle zelené
Usnadnénf pro uZivatele ED/v /A 0) 0/« &/0K
Jazyky nabidky OSD anglictina, francouzstina, némcina, italstina, rustina, Spanélstina,
zjednodusend ¢instina, portugalStina, turectina
Dalsi usnadnénf Z3amek Kensington
Kompatibilita s technologif DDC/CI, sRGB, Windows 7, Mac OSX; Linux
Plug & Play

Naklon -5/+20
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273E3L

Zapnuto

27 W (typicky)

Spotreba energie (Metoda
testovani EnergyStar 5.0)

Stridavé vstupni
napé&tl pri 100

Stridavé vstupnf
napétf pri 115

Strfdavé vstupnf
napéti pri 230

VAC +/-5 VAC, VAC +/-5 VAC, VAC +/-5 VAC,
50 Hz +/-5 Hz 50 Hz +/-5 Hz 50 Hz +/-5 Hz
Normdlni provoz (typ.) 19,6 W 195 W 19,6 W
Spanek 05 W 05 W 05 W
Vypnuto 05 W 05 W 05 W

Rozptyl tepla*

Strfdavé vstupnf
napéti pri 100

Stridavé vstupnf
napéti pri 115

Strfdavé vstupnf
napéti pri 230

VAC +/-5 VAC, VAC +/-5 VAC, VAC +/-5 VAC,

50 Hz +/-5 Hz 50 Hz +/-5 Hz 50 Hz +/-5 Hz
B&Zny provoz 66,89BTU/hr 66,55BTU/hr 66,89BTU/hr
Spanek 1,71BTU/hr 1,71BTU/hr 1,71BTU/hr
Vypnuto 1,71BTU/hr 1,71BTU/hr 1,71BTU/hr

Indikdtor napdjenf

Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blikd)

Napdjenf

Vypdleni, 100-240VAC, 50-60Hz

273E3LH

Zapnuto

<273 W (typ.
<323 W (max)

Spotreba energie (Metoda
testovani EnergyStar 5.0)

Stridavé vstupni
napétf pri 100

Stridavé vstupnf
napéti pri 115

Stridavé vstupnf
napéti pri 230

VAC +/-5 VAC, VAC +/-5 VAC, VAC +/-5 VAC,
50 Hz +/-5 Hz 50 Hz +/-5 Hz 50 Hz +/-5 Hz
Normdlni provoz (typ.) 2043W 20,35W 20,40W
Spanek 05 W 05 W 05 W
Vypnuto 0,3 W 0,3 W 0,3 W

Rozptyl tepla*

Stridavé vstupni
napéti pri 100

Stridavé vstupnf
napétf pri 115

Stridavé vstupni
napéti pri 230

VAC +/-5 VAC, VAC +/-5 VAC, VAC +/-5 VAC,

50 Hz +/-5 Hz 50 Hz +/-5 Hz 50 Hz +/-5 Hz
Bézny provoz 69,73 BTU/hr 69,45 BTU/hr 69,62 BTU/hr
Spanek 1,71 BTU/hr 1,71 BTU/hr 1,71 BTU/hr
Vypnuto 1,02 BTU/hr 1,02 BTU/hr 1,02 BTU/hr

Indikdtor napdjenf

Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blikd)

Napdjenf

Vypidleni, 100-240VAC, 50-60Hz

19




Vyrobek s podstavee (SxVxH)

642 x 440 x 227 mm

Vyrobek bez podstavce (SxVxH)

642 x 391 x 64 mm

Rozméry krabice (5xVxH)

700 x 138 x 525 mm

Vyrobek s podstavcem 8,2kg
Vyrobek bez podstavce 6,5kg
Vyrobek s obalem 8,82kg

Teplotni rozsah (provoz)

0°C az 40 °C

Teplotni rozsah (mimo provoz)

-20°C az 60°C

Relativni vihkost

20% az 80%

Pouzirani: + 12 000 stop (3 658 m)

Nadmorska vyska -
Mimo provoz: + 40 000 stop (12 192 m)
MTBF 30 000 hod.
| Eologe ]
ROHS ANO
EPEAT Certifikdt Silver. (www.epeat.net)
Balenf 100% recyklovatelny

Specifické latky

Prohldseni o shodé

Barva

PVC/BFR Free’ pro souddsti piistupné uzivateli (vyjma kabeld a
adaptért)

Znacka CE, FCC tifda B, SEMKO, TUV/ GS, TUV Ergo, UL/cUL,
Energy star 5.0, TCO 5.1

Cernd/cerna

Povrchova Uprava

Textura/textura

. Certifikdt EPEAT Gold nebo Silver je platny pouze tam, kde spolecnost Philips zaregistruje produkt.

Informace o stavu registrace ve vasi zemi viz www.epeat.net.
Tyto Udaje se mohou zménit bez predchoziho ozndment. Stéhnéte si nejnovejsi verzi letdku z webu

& Poznamka
1
2.
www.philips.com/support.
3.

Souddsti tohoto monitoru pristupné uzivateli (vyjma kabell a adaptérd neobsahuji bromované Idtky
snizujici horfavost ani polyvinyl chlorid (bez PVC/BFR).V téchto ¢dstech nesmfi byt pouzito vice

nez 0,09 % (maximdlné 900 ppm bromu) organobromovych sloucenin ve formé latek snizujicich
horlavost a vice nez 0,1 % (maximalné 1000 ppm chloru) organobromovych sloucenin ve formé
polyvinyl chloridu nebo podobnych latek.
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4.1 Rezimy rozliseni a predvoleb

Kl Maximalni rozliseni

Pro 273E3L/273E3LH
1920 x 1080 pri 60 Hz (analogovy vstup)
1920 x 1080 pri 60 Hz (digitdni vstup)

E1 Doporuéené rozliseni

Pro 273E3L/273E3LH
1920 x 1080 pii 60 Hz (digitélnf vstup)

3147 720x400 70,09
3147 640x480 59,94
35,00 640x480 66,67
37,86 640x480 72,81
37,50 640x480 75,00
37,88 800x600 60,32
46,88 800x600 75,00
48,36 1024x768 60,00
60,02 1024x768 75,03
63,89 1280x1024 60,02
79,98 1280x1024 75,03
5594 1440x900 59,89
70,64 1440x900 74,98
65,29 1680x1050 59,95
67,50 1920x1080 60,00
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5. Rizeni spotieby

5.1 Automaticka uspora energie

Pokud je v daném pocitaci nainstalovdn software
nebo videokarta vyhovujici normé DPM
organizace VESA, monitor dokdze automaticky
sniZit svou spotiebu energie, neni-li pouzivan.
Pokud pocfta¢ rozpozna vstup z kldvesnice,

mysi nebo jiného vstupniho zarizenf, monitor se
automaticky ,,probudi*. Ndsledujicf tabulka uvadf
spotrebu energie a signalizaci této funkce pro

automatickou Usporu energie:

273E3L

Rezim VESA | Video | H-synch. |V-synch.| Spotfeba energie | Barva LED
Aktivni ZAP. Ano Ano <27 W (typ.) Bild
Spének VYP. Ne Ne <05W Bild

(pohotovost) (blikd)
Vypnuto VYP. - - <05W VYP.

273E3LH

Rezim VESA | Video | H-synch. |V-synch.| Spoti'eba energie |Barva LED

Aktivni | ZAP. | Ano | Ano | <273 W (typ) Bl

<323 W (max.)
Spének VYP. Ne Ne <05W Bild
(pohotovost) (blikd)
Vypnuto VYP. - - <03W VYP.

Ndsledujici konfigurace se pouziva pri mérenf
energetické spotreby tohoto monitoru.

Nativni rozlienf: 1920 x 1080

Kontrast: 50%

Jas: 300 nitd

Barevnd teplota: 6500 K's pIné bilym vzorkem

& Poznamka
Tyto Udaje se mohou zménit bez predchoziho
ozndment.
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6. Informace o regulaci
Lead-free Product

Lead free display promotes
environmentally sound recovery

and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated and
compliance with European community's stringent
RoHs directive mandating restrictions on
hazardous substances in electrical and electronic
equipment have been adhered to in order to
make Philips monitors safe to use throughout its

life cycle.

Congratulations!

This display is designed for both you and the
planet!

The display you have just purchased
carries the TCO Certified label. This
ensures that your display is designed,
"’ manufactured and tested according
to some of the strictest quality and
environmental requirements in
the world. This makes for a high performance
product, designed with the user in focus that also
minimizes the impact on the climate and our
natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

*  Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering

* Products are tested according to rigorous
safety standards at impartial laboratories

Electric and magnetic fields emissions as low
as normal household background levels
Low acoustic noise emissions (when
applicable)

Some of the Environmental features of the TCO
Certified for displays:

The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS or
ISO 14001)

Very low energy consumption both in on- and
standby mode minimize climate impact
Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and heavy
metals such as cadmium, mercury and lead
(RoHS compliance)

Both product and product packaging is
prepared for recycling

The brand owner offers take-back options

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as well
as manufacturers all over the world. Since the end
of the 1980s TCO has been involved in influencing
the development of IT equipment in a more user-
friendly direction. Our labeling system started with
displays in 1992 and is now requested by users
and [T-manufacturers all over the world. About
50% of all displays worldwide are TCO certified.

For more information, please visit
www.tcodevelopment.com

TCOFF1058 TCO Document, Ver: 2.1
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EPEAT
(www.epeat.net)

“The EPEAT (Electronic Product

4» Environmental Assessment Tool)

K program evaluates computer
desktops, laptops, and monitors
based on 571 environmental criteria

developed through an extensive stakeholder

consensus process supported by US EPA.

EPEAT system helps purchasers in the public

and private sectors evaluate, compare and select

desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of
performance criteria for the design of products,
and provides an opportunity for manufacturers to
secure market recognition for efforts to reduce
the environmental impact of its products.”

Benefits of EPEAT

Reduce use of primary materials

Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S

requirement that all registered products meet

ENERGY STAR's energy efficiency specifications,

means that these products will consume less

energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following

standards

e EN60950-1:2006 (Safety requirement of
Information Technology Equipment)

* EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment)

e EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment)

e EN61000-3-2:2006 (Limits for Harmonic
Current Emission)

*  EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and Flicker)
following provisions of directives applicable

e 2006/95/EC (Low Voltage Directive)

*  2004/108/EC (EMC Directive)

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive for
Standby and Off mode power consumption)
and is produced by a manufacturing
organization on ISO9000 level.

e The product also comply with the following
standards

e 1SO9241-307:2008 (Ergonomic requirement,
Analysis and compliance test methods for
electronic visual displays)

»  GS EK1-2000:2009 (GS mark requirement)

e prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display)

e MPR-II (MPR:1990:8/1990:10 Low Frequency
Electric and Magnetic fields)

*  TCO Displays 5.0 (Requirement for
Environment Labeling of Ergonomics,

Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions

Energy Star Declaration
(Www.energystar.gov)

As an ENERGY STAR® Partner,

we have determined that this
product meets the ENERGY STAR®
guidelines for energy efficiency.

ENERGY STAR

& Note

We recommend you switch off the monitor
when it is not in use for a long time.



Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to
provide reasonable protection against
harmful interference in a residential
installation. This equipment generates, uses
and can radiate radio frequency energy and,
if not installed and used in accordance with
the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the user
is encouraged to try to correct the
interference by one or more of the following
measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

* Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced radio/
TV technician for help.

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied with
the monitor when connecting this monitor to a
computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to rain
or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity
Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.



Commission Federale de la Communication(FCC
Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces limites
sont congues de facon a fourir une
protection raisonnable contre les
interférences nuisibles dans le cadre
d'une installation résidentielle.
CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil
n'est pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.
Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est la
cause d'interférences nuisibles pour la
réception des signaux de radio ou de
télévision, ce qui peut étre décelé en fermant
I'équipement, puis en le remettant en
fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement et
le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

*  Demander I'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents en
matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour les
connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

Thiz devica belongs to catagory B devices as described in EM 55022, unless it is spacifi-
cally stated that it is a Class A devios on the spacification label. The following applies to
davices in Class A of EN 55022 (radius of protection up to 30 meters). The user of tha
devics is obliged to take all staps necessary to remove sources of intarferance fo tala-
communication or other devicss.

Pokud nenl na typowém &tithu poditade uvedeno, o spadé do do ffidy A podie EN 55022,
spadd automaticky do ffidy B podle BN 55022, Pro zafizenl zafazend do tfidy A (chranné
pésma 30m) podie EN 55022 plati nésledujici. Dojde-li k ruleni telekomunikanich nebo
Finjich zafizeni je ubivatel povinnen provést takovd opatfgn, aby nuSeni adstranil,




Polish Center for Testing and Certification
Notice

The equipment should draw power from a socket
with an attached protection circuit (a three-
prong socket). All equipment that works together
(computer, monitor, printer, and so on) should
have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/T-42107
and PN-89/E-06251.
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR DU
STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)

TECHENERZIRE |




Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den
in der "Verordnung Uber den Schutz vor Schaden
durch Rontgenstrahlen" festgelegten Vorschriften.

Auf der Riickwand des Gerdtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften Uber
die Bauart von Stérstrahlern nach Anlage IIl & 5
Abs. 4 der Rontgenverordnung erfillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.

2. nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildrohre nur eine

bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dunklem
Untergrund zu verwenden (schlechte Lesbarkeit
und erhdhte Augenbelastung bei zu geringem
Zeichenkontrast wdren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel nach
DIN 45 635 betrdgt 70dB (A) oder weniger.

ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.

A

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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7. Péce o zakazniky a zaruka

7.1 Postup pri vadnych pixelech plochého panelu
spolecnosti Philips
Spolecnost Philips se snazi doddvat vyrobky
vyrobnich postup( vyroby v tomto odvétvi a
prosazuje prisnou kontrolu kvality. Defektim
obrazovych bodd nebo dil¢ich obrazovych bod
u paneld TFT LCD, které se pouzivaji pro ploché
monitory, se nicméné nékdy nedd zabranit. Zadny
vyrobce nemUze zarucit, ze vSechny panely budou
bez defektd obrazovych bodu, ale spole¢nost
Philips zarucuje, Ze kazdy monitor s nepfijatelnym
poctem defektl bude v rdmci zaruky opraven
nebo vyménén. Tento text vysvétluje jednotlivé
druhy defektl na pixelech a urcuje dnosnou
Uroveri chybovosti pro kazdy druh. Aby bylo
mozné uplatnit zdrucni opravu nebo vymeénu,
musi pocet defektnich obrazovych bodd panelu
TFT LCD presdhnout tuto Uroveri tnosnosti. Na
monitoru napriklad nesmf byt vice defektnich
dil¢ich obrazovych bodt nez 0,0004 %. Déle,
protoze nékteré typy kombinaci vad pixeld jsou
|épe postrehnutelné nez jiné, stanovuje pro né
spole¢nost Philips jesté vétsi ndroky na kvalitu. Tato
norma se dodrzuje celosvétove.

subpixely subpixely subpixely

N vy
G R G B
pixely

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se sklddd ze tif
subpixelll v zdkladnich barvéch cervené, zelené a
modré. Kdyz je mnoho pixell pohromadé, tvor{
obraz. Kdyz viechny subpixely urcitého pixelu
svitf, jevi se tyto tii subpixely spolecné jako jediny
bily pixel. Kdyz jsou vSechny tmavé, jevi se tyto tfi
subpixely jako jeden ¢erny pixel. Dalsi kombinace
rozsvicenych a tmavych subpixeld se jevi jako
pixely riznych barev.

Druhy pixelovych vad

Vady pixell a subpixell se na obrazovce projevujf
rznymi zpUsoby. Existujf dva druhy vad pixelu a v
ramci téchto druhd je neékolik typl subpixelovych
vad.

Defekty svétlych bodu

Defekty svétlych bod se projevuji jako obrazové
body nebo dil¢i obrazové body, které vzdy svitf
nebo jsou 'aktivni'. Svétly bod je dil¢i obrazovy
bod, ktery vystupuje z obrazovky, kdyz je na
monitoru zobrazena tmava plocha. Existujf
nasledujici typy defektd svétlych bodu:

G

Jeden Cerveny, zeleny nebo modry subpixel

I C

Dva soundlezicl subpixely:

- Cerveny + modry = fialovy

- derveny + zeleny = Zluty

- zeleny + modry = svétle modry

Tri soundlezicl rozsvicené subpixely (jeden bily
pixel)
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€& Poznamka

Cerveny nebo modry sv&tly bod musf byt o vice
nez 50 procent jasné&jsi, nez sousedni body; zeleny
svétly bod je o 30 procent jasnéjsi, nez sousednf
body.

Defekty tmavych bodl

Defekty tmavych bodu se projevuijf jako obrazové
body nebo dil¢i obrazové body, které nikdy
nesviti nebo jsou ,,neaktivni. Tmavy bod je dil¢l
obrazovy bod, ktery vystupuje z obrazovky, kdyz
je na monitoru zobrazena svétld plocha. Existujf
nasledujici typy defektl tmavych bodu:

Vzdalenost pixelovych vad

Protoze vady pixelt a subpixell stejného typu,
které se vyskytuji blizko sebe, mohou byt patrnéjsi,
urcuje spolecnost Philips i tolerance na vzddlenost

vad pixelU.

I Tolerance vad pixelQ

Aby bylo mozné uplatnit opravu nebo vyménu
kvlli defektnim obrazovym bodlm v zdru¢ni dobé,
musi panel TFT LCD plochého monitoru Philips
vykazovat defekty obrazovych bodi nebo dilcich
obrazovych bodu, které priekracuji tolerance
uvedené v ndsledujicich tabulkach.

KAZY JASNYCH BODU

PRIJATELNY POCET VAD

1 trvale sviticl bod 3
2 sousedni trvale svitici body 1
3 sousedn( trvale svitici body (nebo 1 trvale svitici bily bod) 0
Vzddlenost mezi dvéma kazy jasnych bodi* >15 mm
Celkovy pocet kazl jasnych bodd viech typl 3

KAZY CERNYCH BODU PRIJATELNY POCET VAD

1 tmavy bod 5 nebo méné
2 sousedni tmavé body 2 nebo méné
3 sousedni tmavé body 0

>15 mm
5 nebo méné

Vzddlenost mezi dvéma kazy cerych bod(*
Celkovy pocet kazt ¢ernych bodud viech typl

KAZy bodu celkem
Celkovy pocet kazl jasnych nebo cermych bodl vech typd
© Pozniamka

1. 1 nebo 2 sousedni vadné body (1 barva) = 1 vadny bod
2. Tento monitor je kompatibilni se standardem ISO 9241-307. ( ISO 9241-307: Ergonimicky poZzadavek,
analyza a metody testovani shody pro elektronickd zobrazovaci zarizenr)

PRIJATELNY POCET VAD
5 nebo méné
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7.2 Péce o zakazniky & zaruka

Podrobné informace o zaruce a pozadavku na dodatecnou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovnéz mizete kontaktovat mistni centrum péce o zdkazniky na nize
uvedenych telefonnich &slech.

Kontaktni informace pro oblast ZAPADNI EVROPY:

Zemé ASC Cislo zakaznické péce Cena
Germany Siemens &S +49 01803 386 853 €0.09
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0.09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0.08
Netherlands E Care +31 0900 0400 063 €0.10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €007
Belgium E Care +32 078 250851 € 0.06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktni informace pro oblast STREDNI A VYCHODNI EVROPY:

Telefonni stredisko ASC Cislo zikaznické péce
BELARUS NA IBA +375 17 217 3386
BULGARIA NA LAN Service +359 2 960 2360
CROATIA NA Renoprom +385 1 333 0974
ESTONIA NA FUJITSU +372 6519900
LATVIA NA “ServiceNet LV" Ltd. +371 7460399
LITHUANIA NA UAB "Servicenet" +370 7400088
ROMANIA NA Blue Ridge Intl. +40 21 2101969
S e |NA Kim Tec doo. +381 11 20 70 684
SLOVENIA NA PC H.and +386 1 530 08 24
NA Comel +380 562320045
HIRAINE NA EZ;a;;‘;Wice +38 044 245 73 31
. NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware . +36 1 2426331
NA Profi Service +36 1 814 8080

Kontaktni informace pro oblast LATINSKE AMERIKY:

Telefonni stredisko Cislo zakaznické péce
Brazil 0800-7254101
Vermont
Argentina 0800 3330 856

Kontaktni informace pro Cinu:

Cina
Cislo zékaznické péce: 4008 800 008

Kontaktni informace pro SEVERNI AMERIKU:

Telefonni stredisko ASC Cislo zékaznické péce
USA. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696
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Kontaktni informace pro oblast APMEA:

Telefonni <, 2 A B
stFedisko Cislo zakaznické péce
Australia NA AGOS NETWORK PTY LTD [ 1300 360 386
New Zealand NA Visual Group Ltd. 0800 657447
. Hong Kong:Tel: +852 2619 9639
Hong Kong / Macau | NA Smart Pixels Technology Ltd. Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 1o 56477
Ind . NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
Aeonesia Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA s Computer System €O+ (46 934-5498
South Africa NA Sylvara Technologies Pty Ltd | 086 0000 888
UNITED ARAB AL SHAHD COMPUTER
EMIRATES NA LLC 00971 4 2276525
Israel NA Eastronics LTD 1-800-567000
, , +84 8 38248007 Ho Chi Minh City
Vietnam NA EPT Sew'cft';format'c +84 5113.562666 Danang City
SRR +84 5113.562666 Can tho Province
I . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d!strlbutor and/or service
provider currently
Bangladesh NA Distributor: Computer Source | 880-2-9141747, 9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nl NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992
buy-out)
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8. Odstranovani problému a Tlatitko AUTO nefunguje
* Automaticka funkce je pouzitelnd pouze

Caste dOtaZY v rezimu VGA-analogovy. Pokud vysledek
nenf uspokojivy, mizete provést ru¢ni Upravy
prostrednictvim nabidky OSD.

8.1 Odstranovani problému

© Pozniamka
Automatickd funkce nenf pouzitelnd v rezimu
DVI-digitdlni, protoze je zbytecna.

Na této strdnce jsou uvedeny problémy, které
muUze odstranit uZivatel. Pokud problém pretrvavd
I po vyzkousen( t&chto redeni, kontaktujte zdstupce

sluzeb pro zdkazniky spolecnosti Philips. Viditelné znamky koure nebo jiskFeni

*  Neprovddéjte zddné kroky pro odstrafiovanf
problému

*  Pro zajisténi bezpecnosti ihned odpojte

monitor od zdroje napdjenf

lhned kontaktujte zdstupce sluzeb pro

zékazniky spole¢nosti Philips.

El Bé&iné problémy

Zadny obraz (indikator LED napajeni nesviti)

»  Zkontrolujte, zda je napdjec( kabel pripojen .
k elektrické zdsuvce a do zadnf ¢asti monitoru.

*  Nejdrive zkontrolujte, zda se vypinac na prednf
strané& monitoru nachdz ve VYPNUTE poloze 2]

. . , Problémy se zobrazenim
a stisknéte jej do ZAPNUTE polohy.

Obraz neni vystredén

*  Upravte polohu obrazu pomocf funkce , Auto”
v hlavnich ovlddacich prvcich OSD.

*  Upravte polohu obrazu pomoci polozek

. . Phase/Clock (Faze/frekvence) v &asti Setup

»  Zkontrolujte, zda nejsou ohnuté koliky na (Nastaveni) v OSD Main Controls (Hlavni

pripojovac( strané kabeltjvmonitoru. Pokud ovladaci prvky OSD). Tato funkce je platnd
ano, opravte nebo vyménte kabel. pouze v refimu VGA.

* Pravdépodobné je aktivovana funkce rizenf
spotreby

Zadny obraz (indikator LED napéjeni je bily)

»  Zkontrolujte, zda je zapnuty pocitac.

» Zkontrolujte, zda je kabel signdlu radné
pripojen k pocitadi.

Obraz se chvéje na obrazovce

»  Zkontrolujte, zda je kabel signdlu rddné a
bezpecné pripojen ke grafické desce nebo k

Atention pocitaci.

Check cable connection
- Dochazi ke svislému blikani
» Zkontrolujte, zda je kabel monitoru rddné

pripojen k pocitaci. (Rovnéz viz Strucnd

Obrazovka rika

prirucka). , , *  Upravte polohu obrazu pomocf funkce , Auto”
»  Zkontrolujte, zda nejsou ohnuté koliky kabelu v hlavnich ovlddacich prvcich OSD.
monitoru.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Féze/frekvence) v ¢asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddaci prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

» Zkontrolujte, zda je zapnuty pocital.
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Dochazi k vodorovnému blikani

*  Upravte polohu obrazu pomocf funkce , Auto”
v hlavnich ovlddacich prvcich OSD.

* Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v casti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddac( prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz je rozmazany, nevyrazny nebo pFili§ tmavy
» Upravte kontrast a jas na obrazovce OSD.

,Dosvit", ,,vypéleni* nebo ,,zobrazeni duchi*

zUstane po vypnuti napajeni.

*  Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mlze
zpuUsobit , vypaleni obrazovky, rovnéz zndmé
jako ,,dosvit" nebo ,,zobrazeni duchd'.

, Vypélen, , dosvit" nebo , zobrazeni duchd*
je dobre zndmy jev u technologie panell LCD.
V mnoha pripadech , vypdlenf”, ,,dosvit"* nebo
,zobrazenf duchd" postupné zmizi po urcité
dobé& mimo provoz.

* Pred ponechdanim monitoru bez dozoru vzdy
aktivujte spori¢ obrazovky.

*  Bude-li na vasem monitoru LCD zobrazen
nemeénici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.

» Vazné priznaky ,vypdleni*, ,dosvitu" nebo
,,zobrazeni duchd' nezmizf a nelze je opravit.
Na vyse uvedené poskozenf se nevztahuje
zéruka.

Obraz je zdeformovany. Text je nejasny nebo

rozmazany.

* Nastavte rozliSeni zobrazeni pocitace na stejny
rezim, v jakém se nachdzi doporucené nativni
rozlisenf obrazovky monitoru.
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Na obrazovce se objevuji zelené, cervené,

modré, tmavé a bilé tecky

»  Zbyvajici body jsou normdlnf viastnosti
tekutych krystald pouzivanych soucasnou
technologil. Dalsi podrobnosti viz pravidla
pro obrazové body.

Svétlo indikatoru ,,napajeni* je prilis silné a rusi

* MdZete nastavit intenzitu svétla indikdtoru
,napdjeni v ¢asti Power LED (Indikdtor LED
napdjeni) v casti Setup (Nastaven() v OSD
Main Controls (Hlavni ovlddaci prvky nabidky
OSD).

Potrebujete-li dalsi pomoc, viz seznam Informacnf
strediska pro zdkazniky a kontaktujte zéstupce
sluzeb pro zdkazniky spolecnosti Philips.



8.2 SmartControl Lite — casté dotazy

OTAZKA 1:

Odpovéd:

OTAZKA 2:

Odpovéd:

OTAZKA 3:

Odpovéd:

Zménil jsem monitor v poditaci za
jiny a technologie SmartControl Lite
se stala nepouzitelnou, co mam délat?

Restartujte pocitac a zjistéte, zda
technologie SmartControl Lite
funguje.V opacném pripadé bude
treba odebrat a znovu nainstalovat
SmartControl Lite, aby bylo zajisténo,
Ze je nainstalovdn sprdvny ovladac.

Technologie SmartControl Lite drive
dobre fungovala, ale nyni nefunguje,
co mam délat?

Pokud byly provedena nasledujici kroky,
bude pravdépodobné nutné znovu
nainstalovat ovlada¢ monitoru.
Pouzijte jiny graficky adaptér videa
Zaktualizujte ovladac videa

Cinnosti na opera¢nim systému,
napriklad aktualizace nebo oprava
Spust'te sluzbu Aktualizace Windows a
zaktualizujte ovlada¢ monitoru a/nebo
videa

Operacni systém Windows byl
zaveden, kdyz byl monitor vypnuty
nebo odpojeny.

Chcete-li ziskat dalsi informace,
klepnéte pravym tlacitkem mysi na
My Computer (Tento pocitac) a
klepnéte na Properties (Vlastnosti)

-> Hardware (Hardware) -> Device
Manager (Spravce zarizeny).

Pokud je pod polozkou Monitor
uvedeno ,,Plug and Play Monitor"
(Monitor Plug and Play), je treba
provést novou instalaci. Jednoduse
odeberte a znovu nainstalujte
SmartControl Lite.

Kdyz po nainstalovani SmartControl
Lite klepnu na kartu SmartControl
Lite, ani po chvili se nic nezobrazi
nebo se zobrazi zprava o chybé, co se
stalo?

V43 graficky adaptér pravdépodobné
neni kompatibiln{ s technologif
SmartControl Lite. Pokud je vas3
graficky adaptér mezi vyse uvedenymi
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OTAZKA 4:

Odpovéd:

OTAZKA 5:

Odpovéd:

znackami, zkuste stéhnout nejaktudingjsi
ovlada¢ grafického adaptéru z
webovych stranek prislusného vyrobce.
Nainstalujte ovlada¢. Odeberte a
znovu nainstalujte SmartControl Lite.
Pokud presto nefunguje, graficky
adaptér bohuzel neni podporovén. Na
webovém serveru spole¢nosti Philips
zjistéte, zda je k dispozici zaktualizovany
ovlada¢ SmartControl Lite.

Po klepnuti na Product Information
(Informace o produktu) se zobrazi
pouze castecné informace, co se
stalo?

Pravdépodobné nemdte k dispozici
nejaktudlngjsi verzi ovladace adaptéru
grafické karty, kterd pIné podporuje
rozhrani DDC/CI. Pokuste se stahnout
nejaktualnési ovladac grafického
adaptéru z webovych stranek
prislusného vyrobce. Nainstalujte
ovladac.

Odeberte a znovu nainstalujte
SmartControl Lite.

Attention

Theft mode enabled

Zapomnél jsem svuj kéd PIN pro
funkci zabezpeceni proti kradezi. Co
mam délat?

Servisnf stredisko Philips mé pravo
Zadat legitimnf identifikaci a ovéreni
pro zjistén( vlastnictvi monitoru.
Upozormiujeme Vvds, Ze funkce ochrany
proti krddezZi je k dispozici jako snadna
a bezplatnd moznost. Za spravu Cisel
PIN nese vyhradni odpovédnost
konkrétni osoba nebo organizace, kterd
ji jmenuje.

Pokud ¢islo PIN zapomenete, servisni
stredisko Philips jej mUze pro vas
znowu nastavit za nominalni poplatek
po ovérenf vlastnictvi. Upozomujeme
vas, ze na tuto cinnost se nevztahuji
podminky standardni zaruky.



8.3 Obecné casté dotazy

OTAZKA 1:

Odpovéd:

OTAZKA 2:

Odpovéd:

OTAZKA 3:

Odpovéd:

Kdyz nainstaluji svdj monitor, co mam
udélat, kdyz se na obrazovce zobrazi
zprava ,,Cannot display this video
mode* (Tento rezim videa nelze
zobrazit)?

Doporucené rozliseni pro tento
monitor: 1920 x 1080 pri 60 Hz.
Odpojte viechny kabely, potom
pripojte pocitac k monitoru, ktery jste
pouzili predtim.

V nabidce Start opera¢niho systému
Windows vyberte Settings/Control
Panel (Nastaveni/Ovlddaci panely).

V okné Control Panel (Ovlddaci
panely) vyberte ikonu Display
(Zobrazeni). Na panelu Display
Control (Zobrazeni — vlastnosti)
vyberte kartu , Settings" (Nastavent).
Na karté nastaveni v poli ozna¢eném
,desktop area" (pracovni plocha)
presurite posuvnik na 1920 x 1080
obrazovych bodd.

Klepnéte na ,,Advanced Properties*
(Upfesnit), nastavte polozku Refresh
Rate (Obnovovaci frekvence) na 60
Hz a potom klepnéte na OK.
Restartujte pocitac a zopakovanim
kroku 2 a 3 ovérte, zda je pocitac
nastaven na 1920 x 1080 pri 60 Hz.
Vypnéte pocitac, odpojte stary monitor
a znowvu pfipojte monitor LCD Philips.
Zapnéte monitor a potom zapnéte
pocftac.

Jaka je doporucena obnovovaci
frekvence monitoru LCD?

Doporucend obnovovac frekvence
u monitort LCD je 60 Hz. V pripadé
jakéhokoli ruseni na obrazovce ji
mUzete nastavit na 75 Hz a uvidite, zda

rusenf zmizf.
Co jsou soubory .inf a .icm na disku
CD-ROM? Jak Ize nainstalovat

ovladace (.inf a .icm)?

Jednd se o soubory ovladace monitoru.

OTAZKA 4:

Odpovéd:

OTAZKA 5:

Odpovéd:

OTAZKA 6:

Odpovéd:

OTAZKA 7:

Odpovéd:

OTAZKA 8:

Pri instalaci ovladact postupujte podle
pokynl v uzivatelské prirucce. Pri prvnf
instalaci bude pocita¢ pravdépodobné
pozadovat ovladace monitoru (soubory
.infa .icm) nebo disk s ovladadi.
Postupujte podle pokynd a viozte
(doprovodny disk CD-ROM), ktery

je soudasti této sady. Ovladace
monitoru (soubory .inf a .icm) budou
nainstalovany automaticky.

Jak mam upravit rozliseni?

Dostupna rozlisenf urcuje grafickd
karta/ovladac grafiky a monitor.
Pozadované rozliseni mdzete vybrat v
&asti Control Panel (Ovlddaci panely)
systému Windows® v &sti , Display
properties” (Zobrazenf - vlastnosti).

Co kdyz se béhem nastaveni
monitoru ztratim prostrrednictvim
nabidky OSD?

Jednoduse stisknéte tlacitko OK a
potom volbou ,,Reset” (Obnovit)
obnovte vSechna pivodni nastavenf
vyrobce.

Je obrazovka LCD odolna proti
poskrabani?

Obecné se doporucuje nevystavovat
povrch panelu nadmémym uderdim a
chranit jej pred ostrymi nebo tupymi
predméty. Pfi manipulaci s monitorem
nevyvijejte na povrch panelu zadny tlak
ani silu. Mohlo by to negativné ovlivnit
vase zdru¢ni podminky.

Jak Ize &istit povrch monitoru LCD?

Pro bézné cisténi pouzijte Cisty a mékky
hadrik. Pro dlkladné ¢isténi pouzijte
izopropyl alkohol. Nepouzivejte zddnd
jind rozpoustéd|a, jako etylalkohol,
etanol, aceton, hexan atd.

Lze ménit nastaveni barev monitoru?



Odpovéd:

Ano, nastaveni barev mdzete zménit
prostrednictvim nabidky OSD podle
nasledujicich krokd:

Stisknutim tlacftka , OK" zobrazte

nabidku OSD.

Stisknutim tla¢ftka , Sipka dol(i* vyberte

volbu ,,Barva* a stisknutim tlacitka

,OK" prejdéte na nastavenf barev. K

dispozici jsou tfi nastaveni (viz nize).

1. Color Temperature (Teplota
barev): k dispozici je Sest nastavent:
5000K, 6500K, 7500K, 8200K,
9300K a 11500K. Pri nastavenf
v rozsahu 5000K vypadaji barvy
na panelu ,teplé" s ¢ervenobilym
barevnym ténem, zatimco pri
nastaveni teploty 11500K vypadajf
barvy na panelu ,,studené" s
modrobilym barevnym ténem.

2. sRGB: standard pro zajisténf
spravné prienosu barev mezi
rlznymi zarizenimi (napr:. digitdinf
fotoapardty, monitory, tiskdmy,
skenery atd.)

3. User Define (Uzivatelské): uzivatel
si mGze zvolit vlastni nastaven(
barev upravenim cervené, zelené a
modré slozky.

© Poznamka:
Mereni svétla barvy, které vyzaruje predmét pri

zahrivan.

Toto mérenf je vyjddreno v absolutnim mértku
(stupné Kelvina). Nizsi teploty Kelvina, napriklad
2004 K, jsou cervené; vyssi teploty, jako
napriklad 9300 K jsou modré.

Neutrdlni teplota je bild pri 6504 K.

OTAZKA 9:

Odpovéd:

Lze pFipojit tento monitor LCD
k libovolnému poditaci, pracovni
stanici nebo pocitaci Mac?

Ano.Viechny monitory LCD

Philips jsou pIné kompatibilni se
standardnimi pocitaci, pocftaci Mac a
pracovnimi stanicemi. Pro pripojen(
monitoru k systému Mac mize byt
zapotrebi kabelovy adaptér. Dalsf

obchodni zéstupce Philips.
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OTAZKA 10:

Odpovéd:

OTAZKA 11:

Odpovéd:

(D Vystraha

Jsou monitory Philips LCD vybaveny
technologii Plug-and-Play?

Ano, tyto monitory jsou kompatibilnf
s technologii Plug-and-Play v
operac¢nim systému Windows 7, Vista,
XP NT, Mac OSX a Linux

Co znamena |péni obrazu, vypaleni
obrazu, dosvit nebo ,,duch®
v souvislosti s panely LCD?

Dlouhodobé neprerusované
zobrazeni nehybného nebo
statického obrazu méze zpUsobit
,Vvypdleni"* obrazovky, rovnéz zndmé
jako ,,dosvit" nebo ,,zobrazenf
duchd. , Vypdleni,, dosvit" nebo
,zobrazenf duch(" je dobr'e zndmy
jev u technologie panelt LCD.V
mnoha pripadech ,vypdleni*,, dosvit"
nebo ,zobrazeni duchd" postupné
zmizi po urcité dob& mimo provoz.
Pred ponechadnim monitoru bez
dozoru vzdy aktivujte sporic
obrazovky.

Bude-li na vasem monitoru LCD
zobrazen neménicf se staticky obsah,
vzdy aktivujte aplikaci pro pravidelnou
obnovu obrazovky.

Vdzné priznaky ,vypdleni, ,dosvitu" nebo
,,zobrazenf duchd'" nezmizf a nelze je opravit.
Na vySe uvedené poskozen( se nevztahuje

zaruka.

OTAZKA 12: Proc se na displeji nezobrazuje

Odpovéd:

ostry text a pro¢ maji zobrazené
znaky zubaté okraje?

V&s monitor nejlépe pracuje pri
svém nativnim rozliseni 1920 x
1080 pri 60 Hz. Pouzivejte toto
rozliseni pro dosazeni optimalniho
zobrazen.
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